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ProtoPixel Project Tool is a software tool designed to plan and set 
up lighting projects. It takes into account the physical space and 
Project Tools different technologies, while remaining technology 
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01

Setup

System Requirements

ProtoPixel Project Tool is compatible with Windows 8 or superior, Mac OS 12 or 	
uperior, and Ubuntu. You will need at least one ProtoPixel Brain with 22.11 software 
version or greater, and one ProtoPixel ProtoPixel Gate DALI Wired. Finally, lumi-
naires, sensors and switches compliant with DALI2 protocol.

Downloading Project Tool

In order to download Project Tool, you’ll need to register and log in to MyProtoPix-
el. Then, head to the Downloads tab and download the latest version of Project 
Tool for the operating system you use (Windows, macOS, or Linux). You’ll always 
see the last version of Project Tool at the top of the page. Make sure you down-
load the right version.

https://account.protopixel.io/
https://account.protopixel.io/
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Getting Started

Create an account on My ProtoPixel Log-in using a My ProtoPixel Account

To get started, you have two options: create an account and login using your Goo-
gle account credentials, or create an account using your email address and set a 
password. Click on “Use email and password” to create an account using your own 
credentials.

Click on “Sign me Up” to create your account. Enter your email address and click 
on “Sign Up”.  Next, create your password, which should include 8 characters, with 
at least 1 number and 1 capital letter for security reasons. Finally, you will need to 
agree to the Privacy Policy and Terms of Use. You can also choose whether you 
would like ProtoPixel to send you emails with news about future launches and all 
of our activities.  Then click “Sign Up”. In order your account to be confirmed, you’ll 
need to go to your inbox and confirm your address with an email that we’ll send 
you.

02
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Once you have logged in using your MyProtoPixel account, you will land in the 
welcome view of Project Tool. In this view, you will be able to see all the ProtoPixel 
Brains that are connected to the network you are in. To access the installation 
running on a ProtoPixel Brain or create a new one click on the ProtoPixel Brain you 
want to access from the list. Make sure you are on the same network as the Pro-
toPixel Brain you are trying to reach.

If, for some reason, a ProtoPixel Brain that you had previously accessed is no 
longer reachable, you’ll see an alert icon next to it. You should check your laptop 
and/or ProtoPixel Brain connection. 
 In order to disconnect from a ProtoPixel Brain, you need to go to “File” and then 
“Disconnect from ProtoPixel Brain”. You will be headed back to the ProtoPixel 
Brains list. You can learn more about ProtoPixel Brain configuration here.

Connect to ProtoPixel Brain

Access a ProtoPixel Brain Disconnect from a ProtoPixel Brain

https://protopixel.zendesk.com/hc/en-us/articles/7479617057937-Node-network-configuration
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To set up the device, use two rotating switches to assign a static IP address 
within the range of 192.168.11.1-192.168.11.79. The first rotating switch sets the last 
digit of the IP address and can be configured between 1-79. Note that a value of 0 
is not supported, as it sets the Gateway to DHCP configuration.

Open the ProtoPixel Project Tool and click on “Discover Gateways”. This will display 
all the ProtoPixel Gate DALI Wired devices found on the network.

For the ProtoPixel Gate DALI Wired to communicate with the ProtoPixel Brain, the 
ProtoPixel Brain’s IP address must be set to 192.168.11.254.

The ProtoPixel Gate DALI Wired needs to be manually set up and connected to a 
ProtoPixel Brain. To do so, first assign a static IP of 192.168.11.254 to the ProtoPixel 
Brain using the ProtoPixel Brain web application.

ProtoPixel Brain Network 
Configuration UI

ProtoPixel Gate DALI Wired 

Configurating ProtoPixel Brain

Setting up the ProtoPixel 

Connecting to Project Tool

Important
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To change the IP of the ProtoPixel Gate DALI Wired, follow these steps:

1. 	 Connect your laptop directly to the gateway using an Ethernet cable.
2.	  Make sure that the IP address of your laptop matches the IP address of the 	
	 ProtoPixel Gate DALI Wired.
3. 	 Perform this process outside of the Project Tool. Open the terminal on your 	
	 laptop.
4.	  Copy and paste the following text into the terminal, replacing the 		 	
	 placeholder values with your own values:

GREEN: Here, you need to put the desired IP address that you want to replace the 
current one with.
PURPLE: This should be the IP address of your router.
BLUE: This should be the IP address of the ProtoPixel Brain.
BROWN: We recommend putting “static” here to have a static IP.
OLIVE: This is the current IP of the gateway.
After copying and pasting the code and replacing the values in the terminal, press 
Enter. If everything goes as expected, you will receive a “status 200” and the ID of 
the ProtoPixel Brain.

ProtoPixel Gate DALI Wired 

Changing the IP

curl -X POST -H “Content-Type: application/json” -d “{ \”child\”: 0, \”data\”: { \”deviceIp\” : 
\”192.168.11.12\”, \”deviceMask\” : \”255.255.255.0\”, \”deviceGw\” : \”192.168.11.1\”, \”brokerUrl\” : 
\”192.168.11.254\”, \”brokerPort\” : 1883, \”brokerTls\” : false, \”brokerMdns\” : \”none\”, \”ethMode\” 
: \”static\”, \”resetDefault\” : false }}” http://192.168.11.23:8000/config
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To ensure proper connection of all luminaires, you can use the “Broadcast 
gateway DALI” feature to check the installation. To send a broadcast to all 
the luminaires of a ProtoPixel Gate DALI Wired, follow these steps:

1.	  Go to the “Discovery” section.
2. 	 Click on the desired gateway.
3. 	 Find the “Broadcast” option on the inspector panel.

Here, you have different options. You can send the “All on” or “All off” 
command to all the elements or only to the unaddressed ones. To send 
the order and activate or deactivate the selected elements, click on “Send 
broadcast” after choosing the desired elements and command.

Broadcast to a ProtoPixel Gate DALI Wired

Sending Broadcast Commands to a ProtoPixel Gate DALI Wired

Broadcast section of the 
inspector
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When you select a ProtoPixel Brain and there is no installation running on it, 
you’ll need to create a new installation. As soon as you enter the ProtoPixel Brain 
you’ll be asked to name your new installation. Once you enter the name, click 
“Continue”. Next, you will be asked to upload a dxf file to work as your floorplan or 
continue with an Empty canvas.

Create a New Installation

Create an Installation

After logging in and selecting a ProtoPixel Brain, you can either select an existing 
project or start a new one. To start a new project, provide a name for it and confirm 
by clicking on Continue. A new window will appear, where you can either upload a 
DXF file or select to start with an empty space by choosing Empty view. Continue 
without a DXF file.

Refer to Setting up your floorplan (page 15).

Without a Floorplan

Using a Floorplan
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Project Tool’s UI is composed of 
11 main items:

1

2 3 4

5

7

11

8910

6 12

Item	 Part

1	 Left SideBar
2	 Elements & Spaces
3	 Gateways & Integrations
4	 Scheduler
5	 Canvas
6	 Tools: Zoom in, Zoom 	 	
	 out, Expand All
7	 Floorplan Tapbar
8 	 Installation Name 
9	 Floorplans Navigation 
10	 Top Menu Items
11	 Right Sidebar
12	 Status Bar

Getting to know Project Tool’s UI
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Every tab is a different floor plan. And the elements included on the elements’ list 
are placed on the Floor plan the user has selected. You can add all the floor plans 
you need. Floorplans can’t share elements. All the canvas configuration is on the 
Top Menu.

The status bar is the part that displays ongoing background processes. It 
provides information about processes that may take a few moments to complete. 
The status bar keeps you informed about tasks such as saving moods, starting 
scheduler events, and addressing connectivity issues.

Canvas Status Bar

As you use the software, you will see two sidebars: one on the right and one on 
the left. The left sidebar is always visible and displays the following Features:

Sidebar right will appear when a selected item has properties to show, such as 
moods (A Space Property). Right sidebar can display following Features:

Left Sidebar

Here you can see the list of elements you have on your installation, divided by 
Spaces and by placed and unplaced elements.  You can also view all the spaces 
you have created. Spaces group elements and allow you to send context control 
commands, such as moods and CLC. On element’s list, you’ll be able to see if any 
of the Spaces have an enabled CLC.

a.	 Elements

All element, gateway or Space will show a summary of it’s capabilities or 

d.	 Properties

On the discovery menu you will be able to discover all the ProtoPixel Gate DALI 
Wired and elements included in your installation.

b.	 Discovery You can see all the information of this feature on the Moods section. Moods 
feature will be visible when you are on a Space context (you’ll be on the Space 
context if you selected a Space on the Element’s list or one of it’s elements on the 
list, not on the floorplan).

e.	 Moods

Here’s the menu item to access to the Scheduler. You can see all the information 
of this feature on the Scheduler Section.

c.	 Scheduler

You can see all the information of this feature on the CLC section. CLC feature will 
be visible when you are on a Space context (you’ll be on the Space context if you 
selected a Space on the Element’s list or one of it’s elements on the list, not on the 
floorplan).

f.	  CLC — Constant Light Control

Right Sidebar
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1.	 Click on Edit - Floorplan, then the floorplan properties screen will pop up.
2.	 If you want to change the Floorplan / stencil color, click on the Color 	 	
	 selector.
3.	 (Color Square) and the Color selector will be opened.
4.	 You can also change the opacity of the .dxf file on the canvas.

Floorplan Properties

Floorplan Properties Modal Floorplan Color Selector

Working with a Floorplan
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To view or hide the floor plan layers, click on “View” in the top menu and select 
“View Floor plan Layers.” A floating panel will be displayed with the floor plan 
layers, which you can hide or show as needed

You can have as many Floor plans as you need. You can add it by click on Top menu 
/ Edit / Add Floorplan or with the plus (+) button at the top right corner.

This action can’t be undone. All elements placed on this Floor plan will go to the 
Unplaced elements folder . All Spaces and moods configured here will be deleted. 

You can delete the floorplan if you:

1. 	 Are at the floor plan you want to delete
2. 	 Click on top menu / Edit / Delete Floorplan
3. 	 Click on Button Delete Floorplan

View / Hide Floorplan layers Add new Floorplan

Delete FloorplanFloorplan Layers modal

Every tab is a different floor plan. And the elements included on the elements’ list 
are placed on the Floor plan the user has selected. You can add all the floor plans 
you need. Floor plans can’t share elements. All the canvas configuration is on the 
Top Menu.

Canvas
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03 

When starting a new project or opening a new, secondary, floor plan, you have 
the option to either utilize a DXF file or have no stencil on your canvas. Upload a 
DXF file by clicking on “upload” or drag your file into the square dashed pattern. 
Next, you will have the option to select the desired scale. If you do not make any 
changes, the document’s original scale will be used by default. If you wish to 
adjust the scale, you can turn off the “Original Scale” switch. Doing so will provide 
you with options to configure the units per measurement unit. You have the 
flexibility to decide whether to display a grid on your canvas and customize the 
measurement of the grid squares and the unit used. If you want to hide the grid on 
your canvas, simply turn off the Grid Switch.

1.	 Modify Floorplan Name
2.	 Upload file: Drag and drop, or Upload from Files
3.	 Select Scale and Units (If Needed)
4.	 Activate Grid
5.	 Choose Grid Size and Units (If Needed)

Using a .DFX file

Setting up your Floorplan

1

2

3

4

5

Configuring your Floor Plan
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To place elements onto your floor plan, you can simply drag and drop an element 
from the Elements list to the desired location on your canvas.

You have the option to remove elements from the floor plan that you have already 
added. To do so, follow these steps: locate the element on the floor plan, right-
click on it, and choose the “Remove from floor plan” option. This will move the 
element back to the list of unplaced elements. You can place it back on the floor 
plan whenever you need it. Keep in mind that if you remove an element that is part 
of a Space, it will also be removed from the Space.

To zoom in or out on your canvas, you have access to two floating buttons located 
at the bottom of the screen. Clicking the “+” button allows you to zoom in, while 
clicking the “-” button enables you to zoom out. Alternatively, you can also use 
your trackpad or mouse to zoom in or out by scrolling. When you zoom out, you’ll 
notice that elements close to each other will group together in visual clusters. 
It’s important to note that these clusters are purely visual elements designed 
to enhance the organization of your floor plan and do not represent functional 
groups or spaces.

To quickly visualize your entire floor plan, you can click on the “Zoom to Fit” button. 
This action will zoom out the canvas to ensure that the entire floor plan fits within 
the screen.

To navigate through your canvas, you can press the spacebar on your keyboard. 
As you do so, your cursor will change to a hand icon, allowing you to drag the 
canvas and move around freely.

You have complete control over all your elements directly from the Project Tool 
feature. When you select an element from either the Elements list or the floor 
plan, you will immediately see its corresponding control options displayed on the 
Inspector panel.

Place elements on the floor plan

Unplace elements

Zoom In - Zoom Out

Zoom In - Zoom Out

Canvas Panning Control

Navigating your Floorplan
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To connect to the different buses in your installation, navigate to the “Discovery 
& Addressing” panel and click on the “Connect to ProtoPixel Gate DALI Wired” 
option. Immediately after clicking on “Connect to ProtoPixel Gate DALI Wired,” the 
connection process will initiate. You have the option to Stop it at any time.

Discover all the elements on your installation

Once you have your buses visible on the Discovery & Addressing panel, you can 
click on the “Include all devices” option to initiate the discovery process. As it 
progresses, you will observe the number of devices being discovered. Once the 
process is complete, the “Continue” button will become active. Upon clicking it, 
you will be able to see the list of all the elements in your installation.

On only one bus

If you wish to discover only the elements of a specific bus, you need to click 
on that particular bus on the Discovery & Addressing panel. Then, you’ll have 
different options to add and address elements:

1.	 Search for new elements 
	 Add new elements that have not yet been addressed.

2.	 Readdress elements
	 Remove all elements from the Gateway, delete their addresses, and start 
a new addressing process.

3.	 Search addressed elements
	 Search and include already addressed elements.

4.	 Delete all elements
	 Delete all elements addresses and remove them from the Gateway.

Connect to a ProtoPixel Gate DALI Wired

Discover and Include Elements 
in your Network

Connecting to ProtoPixel Gate 
DALI Wired
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Include Simon iO 270 buttons 
to an installation

You can now include Simon iO 270 
button boxes in your ProtoPixel Project 
Tool installation. To do this, you will 
need to have the ProtoPixel App. You 
can download it here.

First, open the ProtoPixel App and 
access the installation where you 
want to include your iO 270 button box. 
Then, open the menu and navigate to 
”Edit installation”. From there, click on 
the ”Add new element” button.

Managing Simon iO 270 buttons in an installation

04 

https://protopixel.zendesk.com/hc/en-us/articles/21350356244369-Download-ProtoPixel-App
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To make your Simon iO 270 device 
discoverable, press one of the buttons 
until the LED indicator starts blinking 
rapidly. Then, click on “Simon iO 
Device”. The search process will begin. 
Ensure that your phone’s Bluetooth is 
turned on and that the Simon iO Device 
is nearby and turned on.

Once added, you will be redirected to 
the main installation screen. You will 
then see the new elements listed in 
both the ProtoPixel Project Tool and 
ProtoPixel App.

Now, you can start adding Behaviours 
to the new element.

Pair with Simon iO 270

04 
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To remove a Simon iO270 button from 
an installation, follow these steps:

1. Open the ProtoPixel Project Tool.
2. Click on the button you want to 
remove.
3. In the inspector panel, locate the 
“Actions” section.
4. Look for the option “Remove element 
from installation” and click on it.

Then confirm that you want to delete 
that element from your installation.

Once deleted, you should see a 
confirmation message that lets you 
know the element is no longer part of 
the installation.

More info about Simon iO 270 devices.

Remove Simon iO 270 from an installation

04 

https://www.simonelectric.com/intl/simon-270/io
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Import ProtoPixel Mapping Tool’s Projects

Having the opportunity of importing ProtoPixel Mapping Tool projects is key in 
order to interact and control SPI, DMX and other types of technologies. You can 
check-out ProtoPixel Mapping Tool’s user guide here.

Save your ProtoPixel Mapping Tool’s project into the ProtoPixel 
Brain

You’ll need to upload your ProtoPixel Mapping Tool project to the ProtoPixel Brain. 

Discover ProtoPixel Mapping Tool Files

Once you have Project Toold your ProtoPixel Mapping Tool project into the 
ProtoPixel Brain, navigate to the Discovery and Addressing section. Under 
ProtoPixel Mapping Tool, you will find the content that you designed using 

Interact with Fixtures from ProtoPixel Mapping Tool

Once you have your ProtoPixel Mapping Tool content visible and included, clicking 
on it will display all the available control options on the right panel. This includes 
the contents you have created and defined for the fixtures.

Project Tool with ProtoPixel Mapping Tool

04 

https://protopixel.zendesk.com/hc/en-us/sections/7450767763217-User-guide
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05 	

To locate an element in your physical installation, select the element you want to 
find. The right sidebar will automatically open. In the right sidebar, you will find the 
“Locate” button. Click on it, and your luminaire will start blinking.

To place elements onto your floor plan, you can simply drag and drop an element 
from the Elements list to the desired location on your canvas.

You have the ability to remove elements from the floor plan that you have 
previously added. First, locate the element on the floor plan. Right-click on the 
element. Select “Remove from floor plan” from the menu. The element will be 
returned to the list of unplaced elements and you can place it back on the floor 
plan whenever you need to. Please note that if you remove an element that is part 
of a Space, it will also be removed from that Space.

Locate Elements Place Elements on the Floorplan

Unplace Element

Elements Management
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05 	

Control your Luminaires

To control a luminaire, you need to select it either from the floor plan or the 
Element’s list. This action will automatically open the properties panel. In the 
properties panel, you will find the selected luminaire’s capabilities and general 
information displayed. The following is the general information about the element 
displayed on the properties panel:

	 — Floorplan where it is placed
	 —Element type
	 —Status (Connected, Unreachable, Synchronizing)
		  Last Updated
    	 	 Replace element action: more information in the Replace
 		  Element Section
	 — Technology information
    	 	 Example: DALI, Dynamic Lighting (ProtoPixel Mapping Tool), etc.
    		  Gateway
    		  Bus name
    	 	 Address (if DALI)

You will only see the selected luminaire’s capabilities, which may include:
Brightness, Color Temperature, OnOff.

Minimum Level, Maximum Level, Fade Time.

Options to delete, reset, or localize the element.

General Info Capabilities Control

Available Configurations

Actions
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05 	

To delete an element from your installation, you need to click on it either in the 
elements list or on your canvas/floorplan. Next, click on the “Remove element 
from installation” option. A confirmation modal will appear where you will need to 
confirm the action by clicking on “Delete element”.  Once you confirm, the element 
will be removed from your installation, including all the spaces and moods where 
it was previously added. Additionally, any behaviors created for that element will 
also be deleted.

How to delete an element

Removing Elements
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Managing Spaces

With ProtoPixel Project Tool, you can create Spaces to organize your luminaires 
into groups of elements and control them collectively. To perform this action, you 
can select the elements directly from the floor plan or from the list of elements 
on the left. Hold down CMD/Ctrl and click on the item or group to select more 
than one. You can also drag on the floor plan to select elements placed within it. 
Once the selection is made, right-clicking will display the option to Create Space 
with the selection. A Space will be created, and you can double-click on the newly 
created space to change its name. To create a Space, all Space elements must be 
placed. Spaces can be accessed from the element’s List menu in the Left Bar.

To add an element to a Space, simply drag and drop it from the Elements list onto 
the desired Space.

When you right-click on an element from the floor plan, you will see the options 
to edit the element, including the option to Remove Element from the Space. 
Alternatively, you can edit the elements of a Space by accessing the list of 
elements located on the left. Right-click on the name of the element, and you will 
see the option to Remove Element from Space. When you remove an element 
from a Space, that element will not be involved in any group action or mood that is 
executed, created, or edited within that space.

Create a Space Add Elements

Remove elements from a Space

06
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07	 Moods

07	 Moods
	 Creating a Mood
	 Edit or delete a Mood

27
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A Mood is a screenshot of the element’s capabilities. 

	 1. First, you need to configure all the brightness, color, and temperature, 		
on all the elements of the Space you are creating the mood in. 

	 2. Then, select the Space on the element’s list menu: the Space proper-
ties menu will be displayed to your right. Select the Mood menu on the right. To 
select the Mood menu, navigate to the right side of the screen. 

	 3. To create a new Mood, click on the “+” button next to “Moods”. Then 
you’ll be able to choose which elements of the Space will be part of the mood you 
are creating.

	 4.  Put a name to the new mood and click on the “Save mood” button. This 
will take a screenshot of the current state of the luminaires you have selected.

	 5. To apply a mood, navigate to the Moods 
menu and select the card of the desired mood.

Create a Mood

Applying a Mood

12 3

3

5

4



33ProtoPixel Suite: Project Tool User Manual
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To edit or delete a mood, navigate to the Moods list. To access the Moods menu, 
select the Space where the mood is configured. Click on the Options icon (    ) on 
the mood card. The options will be displayed.

Editing refers to updating the Mood configuration. When you click “Edit mood” 
you’ll be able to change the moods name. For editing how the mood is and adding 
/ removing luminaires you need to click on the Edit button. When clicking on the 
Edit button, you’ll be able to select which elements are part of that mood.

Once you have all the elements as you need them, you can click on the “Update 
mood” button. That will replace the current status of the elements to create the 
new mood.

Edit or Delete a Mood

Edit
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To delete a mood, click on “Delete” in the options panel. A modal will appear, asking 
you to confirm the deletion action. 

Delete
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08	 Behaviours

08	 Behaviours
	 Create a behaviour for a Button
	 Create a behaviour for a Occupancy 	
	 Sensor
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08 	

Select a Push button from the elements list or the floor plan. Have in mind that 
it needs to be on a Space. Click on “Add behaviour” on the options panel. The 
“Create a Behaviour” panel will open, here you can see Logic conditional boxes 
that are connected. You can configure an “action” to be activated thanks to a 
trigger (“when”).

A behaviour is the action that an element, such as a sensor or a button, 
triggers when it receives a command.

Select the event on the first card and the action you want to be triggered on the 
second card. Once you have selected the action you can save the behaviour and it 
will be showed on the Behaviours section of the Options panel. You will be able to 
see all the behaviours on the Push button Properties panel. To edit any Behaviour, 
click on the Behaviour card (they appear on the Push Button Properties Panel). 
You can’t have more than one action per event type. For buttons, depending on 
the element you have, you can choose between: 

	 — Short press: a quick press on the button
	 — Long press: holding the button down for a few seconds
	 — Release: when the button is released

Once you have selected the action you can save the behaviour and it will be 
showed on the Behaviours section of the Options panel. You will be able to see all 
the behaviours on the Push button Properties panel. To edit any Behaviour, click 
on the Behaviour card (they appear on the Push Button Properties Panel). You 
can’t have more than one action per type of event.

Create a Behaviour for a Button

Selecting Actions

Behaviours
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To create a behavior for an occupancy sensor, you need to select it either from 
the elements list or from the floorplan. Please keep in mind that the sensor needs 
to be included in at least one space. Next, click on the ‘Add behavior’ button. You 
have to select whether the behavior you are defining will occur when the room is 
occupied or vacant.

Then, choose the action that will be triggered, which can involve turning the 
space on or off, or applying a mood. If you choose a mood, you will need to select 
one from the moods you have created for that space. You can also define the idle 
value, which represents the state the space will assume after a certain period of 
no movement detection. Once you have defined all aspects of the behavior, click 
on Save. You should have now a fully configured behaviour. 

Create a Behaviour for an Occupancy Sensor

08 	
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09

CLC 

Activate CLC on a Space Calibrate the sensor for the first CLC use

Our Constant Lighting Control (CLC) feature enables automatic control of lighting 
in your spaces. When CLC is activated in a space, the luminaires in that space will 
automatically adjust their brightness based on the natural light entering from 
outside, as measured by the sensors.

When you first turn on the CLC in a space, you need to calibrate the sensor to 
align its measurements with the values obtained from a luxmeter used to measure 
the space.

The first value you see is the real-time measurement of the sensor. You can 
manually adjust the brightness of the space to achieve a specific value and 
observe how it affects the luminaires. Next, enter the value displayed on the 
luxmeter at the desired location in the “On point value” input field. With this, you 
will link the sensor value with the “On point value” so that it changes accordingly 
and the CLC reaches the target value you set later.  To repeat this action, click on 
the “Re-calibrate sensor” option in the inspector panel.

Note: 	 in order to use the CLC, you need to have a 	
	 luminosity sensor installed in the same space. 	
	 When the CLC is active on a space, you will 	
	 see an icon displayed over the space in the 	
	 elements list.

3.	 To deactivate the CLC, simply turn it 	
	 off in the inspector panel.

1. 	 Make sure you have selected the desired 	
	 space in the elements list.
2. 	 Locate and click on the CLC icon in the 	 	
	 inspector panel.

To activate CLC, follow these steps:
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Configure your CLC

Sensor 
selection

Behaviour 
configuration

Set the target 
value

09 	

In your Space, you may have different sensors. To read the 
luminosity of the space, you need to select the sensor you 
want from the dropdown menu at the top of the inspector 
panel.

In this section in the inspector panel, you can deeply 
configure how your CLC must behave. In the “Idle value” 
section, you can specify the minimum percentage of 
brightness that the luminaires can have. This is important, 
for example, if you want to ensure that the luminaires are 
never completely turned off. 

You can adjust the percentage of brightness variation 
for the luminaires to change at specific intervals, which 
allows for a smoother or faster experience. For instance, if 
you prefer smoother transitions, increase the amount of 
time and decrease the maximum variation. Conversely, if 
you need changes to be reflected quickly, opt for a larger 
variation every few minutes.

Once you have calibrated your sensor, you need to define 
the desired value for your space. This is the target value that 
the CLC’s Project Tool will continuously try to reach.
To define this value, enter the lux value in the “Desired value” 
input field in the inspector panel.

To ensure that the desired value is reached, you need 
to check that the “On point value” matches the “Desired 
value.” Please keep in mind that sometimes the number of 
luminaires may not be sufficient to achieve high values.
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10

When you first access the scheduler, you will be prompted to configure certain 
aspects in order to use it. The following items need to be defined:

	 — Time zone: This will ensure that Project Tool accurately manages your 
events by taking into account the appropriate time zone.
	 — Time and date format: Depending on your installation’s region, you may 
prefer to display the date and time in a specific format.

Fill all data and click continue. This will automatically open the calendar view. To 
create an event on the scheduler, click on the “Create Event” button located at 
the top right corner of the screen. After clicking on the “Create Event” button, 
the Event Sidebar will appear. Write a name for your event in the designated 
field. Next, choose the date for your event by selecting the desired date from the 
date picker. Select the time for your event by choosing the appropriate hour and 
minute from the time picker.

Configure your scheduler
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10

You can set an end time for your event. If you don’t choose any end time, the 
event will last until the next command or action is triggered. In order to set a end 
time, just turn on the “Ends” toggle and set the end time. If you need an event 
to be recurrent, you can click on Repeats link when editing it. A modal with the 
recurrence options will display.

In the Event Sidebar, click on the “Action” button. A window with all the available 
actions will pop-up, which includes: Apply Mood, Turn on Space, Turn off Space,
and Enable CLC. Once you selected the desired action, click on “Save event”.

Configure your scheduler Choose Action
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10

To edit or delete an event, locate the event on the scheduler view. Once you have 
identified the event, click on it to select it. A sidebar will appear on the right side 
of the screen, displaying event details and options. In the top right corner of 
the sidebar, you will see two icons. Delete event: Click on this icon to delete the 
selected event. Edit Event: Click on this icon to make changes to the selected 
event, such as modifying the name, date, time, or action associated with it.

Month view displays all the events for the current month. You can navigate 
through months by using the arrows located at the top left. To configure the 
timezone: If you need to change the timezone after creating events, you can do 
so by clicking on the Filters icon in the timezone section.

Edit or Delete Events Scheduler Viewing Options: Month View
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10

You can obtain a more detailed view of the scheduled events for the week by using 
the week view. You can navigate to different weeks by using the arrows.

If you require a more comprehensive overview of the day, click on the day view. It 
will display the current day, and you can navigate through days by clicking on the 
arrows located at the top left. To configure the timezone: If you need to change 
the timezone after creating events, you can do so by clicking on the Filters icon in 
the timezone section.

Week View Day View
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For more information 
and inquiries, contact 
us at protopixel.io 

https://www.protopixel.io/
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Mapping Tool Overview

About

Design functional and emotional moods for your spaces. The ProtoPixel Mapping 
Tool gives you all the power of high-level lighting software with all the benefits of 
a short learning curve.

Features

— Offsite & Onsite mode (any device is needed to start a project)
— Content Library ready to be used
— Compatible with ProtoPixel Controllers as well as Art-Net.
— Lighting Content Preview
— Offline Backup
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Concepts

How the ProtoPixel Mapping Tool Works

The ProtoPixel Mapping Tool is a pixel mapping software that helps you map 
visual content to physical lights in the real world. To do so, you will have to match 
places in your content to individual lights in the real world. Fortunately, this is 
very easy with the ProtoPixel Mapping Tool. Some key concepts are needed to 
understand and use the ProtoPixel Mapping Tool:

Light

In the ProtoPixel Mapping Tool we use Light to refer to a single controllable point 
of light, which can only have one color. A Light will typically be an addressable LED. 
We represent it as a point in space with a given color.

Devices

Devices are how real-world ProtoPixel Controllers are represented in the software. 
Typically you would set up a Controller, fill in its Outlets, and then pair it to the 
physical Device. How fixtures are connected to the outlets of the Controller must 

Project

All these elements are placed together in a Project. A Project can be saved in a file 
for later use.

Content

Anything that produces color that can be mapped into lights is Content. Videos, 
images, and interactive animations are examples of Content.

Controller and Outlet 

A Controller represents how the physical Fixtures are connected in a particular 
ProtoPixel Controller. Controllers have several Outlets representing the physical 
connections where Fixtures can be plugged. A Controller has to be paired to a 
Device to work in the real world.
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System Requirements

System Requirements

—A computer with 4GB of RAM or more
—A ProtoPixel Brain Experience and/or a ProtoPixel Gate SPI Wired

System Architecture

Operating Systems 
 
—macOS High Sierra 10.13 or later
—Windows 8 or later
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Install the ProtoPixel Mapping Tool

To install the ProtoPixel Mapping Tool, please follow the steps 
below: 

	 —Start by downloading the ProtoPixel Mapping Tool from MyProtoPixel. 		
	 This will ensure you have the latest version of the tool.
	 — If you are using a MacOS, locate the downloaded dmg file and dou		
	 ble-click on it to unzip it. Once unzipped, open the dmg file and drag the 		
	 ProtoPixel App into the Applications folder.
	 — For Windows users, simply double-click on the Installer file and follow 		
	 the on-screen instructions to complete the installation process.
	 —After the installation is complete, find the ProtoPixel Mapping Tool icon 	
	 on your MacOS desktop. Double-click on the icon to launch the applica		
	 tion.
	 —On the first launch, you will be prompted to click on “Open” to start 		
	 using the ProtoPixel Mapping Tool. 

Please note that the above instructions are specific to MacOS and Windows op-
erating systems. If you encounter any issues during the installation or launching 
process, refer to the official ProtoPixel documentation or seek assistance from 
their support team.

Important: The Mapping Tool must be opened by right-clicking 
on the application and choosing the Open option. Do not “double 
click” on the application.
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ProtoPixel Mapping Tool Licenses

	 —Access this website, also 
accesible by going to “Window > 
Subscription Account”. 
	 —Enter the email address to 
which the license will be assigned and 
create a password for it.
	 — Click on the “Purchase 
now” button and follow the steps to 
complete the purchase.

Activation Token

If you have an Activation Token, 
you need to your navigation bar 
and go to “Help > Subscription” 
Next, add your email and the 
provided Token. Afterwards, click 
on “Activate”.

A web browser will open where you 
may be prompted to enter your email 
address. Please ensure that the email 
address you provide is the same one 

After clicking on the “Assign 
subscription to this Computer” button, 
a message will appear stating that 
“Your subscription is assigned to this 

A license is tied to a single computer. Make sure you follow all 
these steps on the same computer you will be using the 
ProtoPixel Mapping Tool.

Once you have purchased the license 
online, you need to add it to your 
computer. Ensure that you do not 
close the ProtoPixel Mapping Tool 
during this process.

To add your license to your computer, 
navigate to Window > Subscription 
Account.

used to purchase your license. To 
assign the license to this computer, 
click on the “Assign subscription to this 
Computer” option on the website.

computer”. Now you can close and 
reopen the Mapping Tool to see the 
license reflected in the software.

To install the ProtoPixel Mapping Tool, please follow
the steps below: 
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ProtoPixel Mapping Tool Interface

The ProtoPixel Mapping Tool user 
interface is composed by several panels, 
showing the important information about 
your project.

Toolbar
Scene Panel
Controllers Panel
Inspector Panel
Workspace

1
2
3
4
5

1A B C D E F

2

3

4

5

Toolbar

The toolbar has many tools for fast 
access, these are:

A	 Project operations: Open, 	
	 Open Recent, New, Save
B	 Undo, Redo.
C	 Alignment Operations: Align 	
	 Left, Horizontal Center, Right, 	
	 Top, Vertical Center, Bottom, 	
	 Spread Horizontally, Spread 	
	 Vertically.
D	  New Fixture Menu.
E	  New Content Menu. 
F	  Global Properties.
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ProtoPixel Mapping Tool Interface

Scene Panel

The Scene Panel lists all Entities 
(Contents and Fixtures) in your 
Workspace. With it you can:
- Select an Entity (Click).
- Reorder an Entity (Drag & Drop).
- Center your Workspace on an Entity 
(Double-Click).
- Select multiple Entities (cmd + Click).
- Select a range of Entities (shift + 
Click).

Controllers Panel

The Controllers Panel lists all 
Controllers and Outlets in your project. 
A Controller is just a group of Outlets. 
You can later bind a Controller to a real 
Device  (see Creating and Configuring 
a Controller). In the Controllers Panel, 
you can:
- Add a new empty Controller (Click the 
+ on the Panel title).
- Select a Controller or Outlets (Click 
it).

- Make an Entity non-interactive (Click 
on the Entity’s Lock icon).
- Hide a Content from your Workspace 
(Click on the Content’s Eye icon).
- Filter Entities by Name (type on the 
top Search Box).

- Hide the Outlets of a Controller (Click 
its V).
- Deactivate a Controller to stop it from 
sending data (Click its switch).
- Deactivate all Controllers (Click the 
switch on the Panel title).
- Hide the Controller Panel (Click the v 
on the Panel title).
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ProtoPixel Mapping Tool Interface

Inspector

This panel will show all the properties 
of the selected item. Some of those 
properties can be changed. The 
name of the selected item can also 
be changed just by editing it and 
pressing Enter. You can also cancel the 
edit by pressing Esc.

Workspace

In the Workspace, you can move and 
transform Fixtures and Contents by 
dragging them and using its handlers. 
Moving two fingers on your trackpad 
will move the workspace. You can 
zoom in or out of the Workspace with 
a pinch gesture or by pressing Cmd + 
scrolling up or down. The slider on the 
top right lets you manually control the 
zoom level and the bulb icon activates 

and deactivates the *Preview Mode*. 
In *Preview Mode* all contents are 
hidden and the lights are rendered in a 
more realistic way. You will find an FPS 
indicator in the bottom right corner of 
the Workspace.

Recording Input

ProtoPixel Mapping Tool allows the 
recording of output for two different 
situations: For a single autonomous 
controller and for multiple standard 
ProtoPixel Controllers. These 
recordings are only useful if you have 
a ProtoPixel autonomous Controller 
or a ProtoPixel Player.
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ProtoPixel Mapping Tool Interface

The Log Window

The Log Window shows messages from 
the ProtoPixel Mapping Tool Core. It is 
useful to debug scripting content. To 
show the log window go to Window > 
Log Window or press Cmd+L. Also, you 
can access the menu bar by selecting 
Window > Log Window
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Workspace

Elements

Navigating the Workspace

As you may have noticed, items 
are created in the center of the 
Workspace. To navigate through it, 
you can right-click and drag, use the 
trackpad, or use the mouse wheel. 

Selecting Workspace Elements

You can select various Workspace 
Elements (such as Fixtures and 
Contents) to operate on them 
simultaneously. To initiate multiple 
selections, hold cmd and click on the 
elements you want to select, either on 
the Workspace or the Scene Panel. You 
can also use square-select by clicking 
and dragging the pointer across the 

When you click on an element in 
the workspace, a Gizmo will appear, 
enabling you to transform it. To move 
an element, simply drag it using the 
pointer. To rotate it, drag the rotating 
handle (blue) (press shift to rotate in 
15º steps). To scale it, drag one of the 
edges of the bounding box. To restore 
the aspect ratio, use the “Aspect Ratio” 

button in the Inspector Panel.
You can also select multiple elements 
to apply these operations collectively.
When an element is selected, its 
properties are displayed in the 
Inspector Panel.

Configuring and Manipulating an Element 

To zoom in and out, you can use the 
pinch gesture or hold the Ctrl key while 
scrolling vertically.
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Elements

Aligning and Distributing 
Elements

To align the selected elements, you 
can use one of the Alignment and 
Distribution tools available in the menu.
The alignment tools include vertical 
and horizontal alignment to the center 
and edges. The distribution tools 
work in both vertical and horizontal 
directions. Alignment is always 
performed using a selected group of 
elements as a reference.

You can copy and paste Elements 
using cmd+C and cmd+V key 
combinations, or using the menu 
(Edit > Copy and Edit > Paste). You 
can select any number of items to 
be copied. Pasted items will maintain 
the properties of the original, with a 
position offset. Pasted elements get 
automatically selected.

You can perform a quick copy-
paste action by duplicating the 
items: cmd+D or Edit > Duplicate.
performed using a selected group of 
elements as a reference.

Copying and duplicating Elements
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Fixtures

Creating a Fixture

To create a new Fixture, click on 
the Fixture tool in the toolbar. This 
will display the different Fixture 
alternatives available for creation. 
Select the desired fixture type 
to create it. The new Fixture will 
appear selected in the Workspace. 
Alternatively, you can go to Workspace 
> New Fixture… > Fixture Type.

In the inspector panel, you can adjust 
various properties that will affect 
how the fixture interprets colors in 
ProtoPixel. The first set of properties 
you will encounter are the ones 
that determine the size, shape, and 
connection of the fixture. These 
properties will differ depending on the 
specific fixture. Following that, you will 
find a series of parameters (table).

Configuring Fixture Properties

White Functions

There are several ways to extract the 
white component from an RGB color:
	 Mix: This method extracts 
the white component from the color 
and uses it as the white level. Pure 
white colors will not use the RGB 
components. Avoid using this function 
in a fixture without a white component, 
as it may result in incorrect colors.
	 Average: In this method, the 
white component is calculated as the 
average of the RGB components. This 
will yield slightly whiter colors.

Color Modes

Here you select how the fixture should 
use the color from the content:
	 Original: The original RGB color 
is used.
	 Monochromatic: The intensity 
of the color is used to modulate the 
Base color.
	 Color: This will ignore the 
original RGB color altogether and use 
the Base Color directly.

Parameter

ON

Level

ProtoPixel Gamma Correction

ProtoPixel Temporal Dithering

ProtoPixel Double Points

Force Channel

Fixture Type

Custom Ordening

White Function

Color Mode

Base Color

Base Color Transition Time

Transition Delay

Element / Zone

Function

Switch on and off output for this fixture

Intensity of the light of the fixture

Apply the gamma correction to the color

Try to get fine grade colors by adding some noise

Every pixel of the fixture should be sent twice

Select the adress for DMX luminaries  

List of preset byte orders. This will depend on the fixture 

hardware 

Define the ordering manually according to the fixture

Select average or mix 

Select original, monochromatic, or color. 

Color used as a base, depending on the Color  

Set up the transition time of the colors on dynamic 

contents

Set up delay transition 

Name the fixture or group of fixtures

Parameters Table
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Controllers

To establish communication with real-
world fixtures and send them lighting 
information, we need to establish 
a connection with the physical 
ProtoPixel Controller and specify how 
the fixtures are connected to the 
device. To add a controller, navigate 
to the Controllers Panel tab and click 
on the add icon. A new controller will 
be created with a default number of 

ProtoPixel Controllers do not have 
any information about how fixtures 
are connected to them. Therefore, we 
need to describe this information in 
the software. This allows the software 
to send the color information to the 
Controller in the correct order. To 
begin, we need to add the Fixture to 
the appropriate Outlet. To do this, first, 
select the Fixture. This will display 
its properties in the Inspector. Then, 
use the list to change the assigned 

outlets. You can modify the number of 
outlets in the Inspector.
There are two remaining actions:
- Adding fixtures to the outlets.
- Connecting the controller to a device.
average of the RGB components. This 
will yield slightly whiter colors.

controller and outlet. If multiple 
fixtures are added to the same outlet, 
it is necessary to define the correct 
order in which they are connected to 
match the physical setup. To do this, 
select the *Outlet* in the Controller 
Panel and use the inspector to drag 
and rearrange the fixtures. As you 
select the outlet, a preview of its 
wiring will appear on the workspace. 
The starting point of the outlet is 
represented by a vertical line.

Configuring Fixture Properties

Adding Fixtures to Outlets

Inspector Window:
Line Section

Outlet lines and order
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Controllers

Now that we have added Fixtures 
to Outlets, we need to connect 
your Controller to an actual 
Device. ProtoPixel Controllers are 
automatically detected when they 
are connected to the same network 

If the Controller cannot connect to the 
device, its name will appear in red in 
the Controller Panel until it reconnects 
again. You might be interested in the 
ProtoPixel Gate SPI Wired Controller 

This typically occurs when the device 
is on a different subnetwork. Make sure 
that all controllers are on the same 
subnetwork as the computer running 
ProtoPixel Mapping Tool, and that the 
network mask allows for connectivity.

Depending on the type of LEDs being 
used, you may need to adjust their RGB 
order to accurately represent colors 
in the real world. To do this, select all 
affected fixtures and modify their “PPx 
RGB ordering” property.

Some Controllers may be inaccessible 
depending on their connection. While 
ProtoPixel Mapping Tool may be able 
to detect them, it may not be able to 
establish a connection or send data 
to them. In such cases, a warning with 
relevant information will be displayed 
next to their current IP property.

👉 👉

👉👉

👉

as your computer. To pair a controller 
with one of the detected devices, 
select the Controller (this will display 
its properties) and choose the device 
from the list. This will also display the 
Device’s properties in the Inspector.

Connecting a Controller to a Device

Best Practices

You can modify certain parameters of 
the device in the inspector, depending 
on its capabilities. Refer to the table in 
the “Configuring the controller” section 
for more details.

Inspector Window: Devices

https://protopixel.zendesk.com/hc/en-us/categories/9334941500945-DUO


55ProtoPixel Suite: Mapping Tool User Manual

02

Content

Now that we have Fixtures in the 
Workspace and have mapped them 
to real-world Fixtures, we can begin 
mapping content into them. To create 
content in the workspace, we can 
either press the Content menu in the 
Toolbar or use the Workspace > New 
Content… > Menu. We then select 
the desired type of content. Some 
content types require a file to function 
(such as images, videos, and scripts). 
These contents can be created by 
simply dragging the file directly into 
the workspace. As an example, we 
could create a Test content to verify 
if everything is set up correctly. This 
content consists of four squares of 
different colors rotating.

This content defines a solid color. 
Adjust the color and temperature using 
the palette.

The ProtoPixel Mapping Tool includes 
several bundled types of content:

1	 Color
2	 Image
	 Video
4	 Script
5	 Syphon
6	 Test

**All types of content have an Alpha 
parameter that can be adjusted to 
change their transparency. Also, 
some contents can be configured to 
determine their alignment.

Adding Content

Content Types: Color

Parameter

Texture Filtering

Texture Horizontal

Texture Vertical

Meaning

Define if the pixels should blur 
between them

Offset move the content texture 
horizontally

Offset move the content texture 
vertically

Inspector Window: Color

Color ContentTunable White Full Spectrum
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Content

 This content imports an image. It 
supports the following formats:  
 
.tiff

.jpg

.png

Plays a video and maps it with the 
lights. The Inspector provides controls 
to play and stop the video. You can also 
adjust the volume and enable video 
looping.
Although the ProtoPixel Mapping 
Tool is capable of playing many video 
formats, we recommend using the 
following specifications:

- Container: mp4 (MPEG-4)
- Resolution: 1280x720 or lower
- Codec: H.264

You might find the Video Codec 
Specifications for Brain Experience 
article interesting. 

More info on Video Codecs here.

This content provides a quick way to 
test content on fixtures. It consists 
of an endless video featuring rotating 
RGB squares of different colors.

 You might be interested in Content 
from Library

You can create interactive content 
with software like Resolume, 
Modul8, Millumin, or even audiovisual 
interactive tools like Processing. By 
using Syphon technology, you can 
import image content directly into 
ProtoPixel. To do this in the ProtoPixel 
Mapping Tool, activate the Syphon 
output in the software you want to use.
Next, add a Content > Syphon and 
select the desired application from 
the Source drop-down menu in the 
Inspector panel. The content will 
appear in the view and can be mapped 
like any other content.

Image Video Test Syphon

https://protopixel.zendesk.com/hc/en-us/articles/8284891460881-Video-Codec-specifications-for-Node
https://protopixel.zendesk.com/hc/en-us/articles/8284891460881-Video-Codec-specifications-for-Node
https://www.notion.so/protopixel/Video-codecs-5d4ed609c1c349929ed97de9f727a80b
https://protopixel.zendesk.com/hc/en-us/articles/9919505090577-Library-contents-in-Create
https://protopixel.zendesk.com/hc/en-us/articles/9919505090577-Library-contents-in-Create
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Content

The ProtoPixel Mapping Tool offers 
scripting capabilities for creating 
interactive content. It is based on 
the Python programming language 
and incorporates bindings to open 
Frameworks, a popular creative coding 
library. To familiarize yourself with 
ProtoPixel Scripts, you can refer to the 
provided examples. We recommend 
using a Python-aware editor, such 
as pyCharm or Sublime Text with 
Python addons, to edit the scripts 
externally. When saved, the programs 
will automatically reload in ProtoPixel. 

With the Mapping Tool, you have 
access to various default content 
options that you can customize to 
unleash your imagination and create 
incredible new content. Library 
contents in the Mapping Tool.

- Make sure that you have installed a 
text editor on your machine.
- These instructions only work for 
the Mapping Tool (formerly known as 
Create) 3.0 or higher versions.

Script

Content Library Shaders

For advanced graphics generation in 
scripts, you can also use the pyOpenGL 
bindings after installing them 
separately.
To use a Script Content, create a 
python file and import it into the 
ProtoPixel Mapping Tool. Any errors in 
scripted programs will be displayed in 
the Log Window.
During execution, you can add various 
input elements to the properties of 
your script. The Mapping Tool will 
check for new inputs each time you 
click on the script content.

1. Go to the file package that you 	
have downloaded, which 	
contains the MappingTool.dmg file.
	
   	  a. Open the ‘examples’ folder.
   	  b. Open the ‘scripting’ folder.
   	  c. Drag and drop the shader.
py.  Python file onto the Mapping Tool 
workspace canvas.

2. Select the shader you want to 
import.
    	 a. Go to your browser and 
search for the desired shader in a 
repository, such as shadertoy
    	 b. Identify the suitable shader 
for your project.
	 c. Copy the code of the shader.
    	 d. Paste the code into a text 
code editor.
    	 e. Save the file on your machine.

3. Import your shader into the 
Mapping Tool:
    
	 a. In the Mapping Tool, select 
the shader object (represented as a 
transparent square).
	 b. From the inspector panel, 
select the shader path where you have 
stored the code. 

Please ensure that your chosen 
shader does not have any external 
dependencies (check the information 
available in the ‘iChannel’). If it does, 
it might not work in the Mapping Tool 
because those external sources would 
not be embedded.

Steps for importing shaders into the ProtoPixel Mapping Tool

https://protopixel.zendesk.com/hc/en-us/articles/9919505090577-Library-contents-in-Create
https://protopixel.zendesk.com/hc/en-us/articles/9919505090577-Library-contents-in-Create
http://shader.py/
http://shader.py/
https://www.shadertoy.com/
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Export Projects

Once the project is correctly mapped 
in the ProtoPixel Mapping Tool, from 
the menu bar select the option Project 
> Export select a location, and name 
it. The file will be saved with the 
extension .ppxexp. 
There are two kinds of projects:

1. The bare project is a file with a 
.ppxproj extension. It is created when 
you save a project. It only contains 
the essential parts for it to run on your 
computer.
- The bundled project is a file that also 

has a .ppxexp extension. It is created 
when you export a project. It contains 
a bundle of all assets needed to run 
your project on any computer (videos, 
scripts, …). this is the necessary 
extension to upload a project to the 
Brain Experience.

To export your project go to Project > 
Export, or use cmd+E.

How to Export

https://protopixel.zendesk.com/hc/en-us/articles/7244699793681)
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Recordings and ProtoPixel Gate 

In order to use the ProtoPixel Gate 
SPI Wired in standalone mode you 
will first need to make content for the 
ProtoPixel Gate SPI Wired to playback. 
This is done using the ProtoPixel 
Mapping Tool software which will allow 
you to make recordings that can be 

First define the fixtures in the Mapping 
Tool that you to control using the 
ProtoPixel Gate SPI Wired.
Make sure that you have a controller 
with 1 or 2 outputs configured and 
that these are assigned to the 
corresponding fixtures that you 
intend to make the recording for. The 
recording will capture the all of the 
information generated when you run 
the content in the Mapping Tool and 
“hit record”, this includes which output 

You can now start designing and laying 
out the content in the Mapping Tool 
that you wish to capture with the 
recording process.

In the Mapping Tool inspector panel, 
you will find the Recording section.
Here you need to define the recording 
name, select your controller and the 
path where you want to store the 
recording. By default, the recordings 
will be saved in your Documents folder 
(e.g. on Windows: C:\Users\YourName\
Documents\ProtoPixel\Recordings)
You will also need to define the frame 
rate you want your recording to be 
saved.

Once you have completed steps 1, 2 
and 3 you are ready to record. Run 
the content sequence that you wish 
to capture then click on the “Start” 
button to record. Once your content 
sequence is done you need to click the 
“Stop” button. Your recordings will be 
automatically saved to the path you 
defined in step 3.

If you think that you may 
upgrade your install to use a 
ProtoPixel Brain Experience 
to control the ProtoPixel Gate 
SPI Wired in the future now is a 

Note that the format 
you must select from 
the recording panel in 
the Mapping Tool for the 
ProtoPixel Gate SPI Wired

TIP: Add a suffix in your 
recording name indicating the 
frame rate (e.g. “_60fps”). It 
will be useful when uploading 
the file to your ProtoPixel 
Gate SPI Wired with the Player 

A REC hint will appear in the 
Mapping Tool canvas (bottom 
right) to show when you are 
recording

Create a Recording

Step 1: Lighting Fixtures

Step 2: Lighting Content Step 3: Recording Storage Step 4: Record

👉

👉

👉 👉
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Global Settings

There are several global settings that can be accessed through the global 
settings button in the Toolbar. Here is a description of each setting:

This name is used to notify you 
about expiring subscriptions or other 
installation-related events.

Installation Name

Specifies the path to a project that will 
automatically load when running the 
ProtoPixel Mapping Tool. This is useful 
for autonomous installations.

Starting Project

Enables sound processing for scripts 
that require it.

Process Sound

Sets the maximum framerate for the 
entire application.

Global Framerate

Refers to recording output for a single 
SD Controller

Manual Artner Devices

Refers to the scheduler feature.Scheduler

Refers to recording output for a 
ProtoPixel Player.

Recording

Limits the quality of the preview in 
the ProtoPixel Mapping Tool. This 
does not affect the quality of the LED 
output, but reducing it can improve 
performance.

Preview Quality

It is recommended to keep this option 
activated for better performance. 
However, some older systems may 
actually perform better with it 
deactivated.

Async Rendering

The program periodically saves your 
work so that you can recover it in case 
of an outage or a crash. If a backup 
project is found when starting the 
application, a dialog will prompt you to 
recover it.

Autosave
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Video Codecs

To avoid issues with projects that include video files, ensure that the video codec 
is correct.

To use them, you will need to import 
the presets from the table in the 
following way:

1. Download the file Proto-RF24-
Max720p (1).json.
2. Open Handbrake
3. Click on ‘Presets’.
4. Click on ‘Import’.

If you are using the ProtoPixel Mapping 
Tool on Windows, a pop-up will appear 
during the installation process 
suggesting the installation of the 
codec pack. This message typically 
appears when you open the Mapping 
Tool for the first time on Windows, 
as well as when you try to add video 
content.

If you have ignored the suggestion, you 
can download the codec pack here.

You can find more info and 
resources here.

https://protopixel.zendesk.com/hc/en-us/article_attachments/10488551122321/Proto-RF24-Max720p__1_.json
https://protopixel.zendesk.com/hc/en-us/article_attachments/10488551122321/Proto-RF24-Max720p__1_.json
https://handbrake.fr/.
https://codecguide.com/download_kl.htm
https://mattgadient.com/comparing-x264-rf-settings-in-handbrake-examples/
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Spaces

Spaces is a tool for controlling 
various types of lighting, from 
everyday environments like offices 
to immersive experiences. This guide 
will demonstrate how ProtoPixel 
Spaces serves as the configuration 
co-pilot of the ProtoPixel platform, 
providing a control interface for users. 
It seamlessly integrates with other 
components of the suite, including the 
advanced lighting design software, 
ProtoPixel Mapping Tool, and the 
hardware device, ProtoPixel Brain 
Experience. Spaces enable users 
to create and manage their lighting 
environments, utilising moods, 
widgets, and rules for everyday use.

You can use Spaces as if you were on 
your mobile phone, but directly from 
the Project Mapping Tool. To do this, 
go to Window - Spaces. When Spaces 
is enabled, you will see an “Spaces 
enabled” alert at the bottom of the 
canvas, indicating that the installation is 
being controlled with Spaces.

For detailed instructions on how to use 
Spaces, please refer to its manual.

https://protopixel.zendesk.com/hc/en-us/categories/9334906721681-Spaces
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DMX

To use DMX, you have to edit the 
properties of the fixture (imagine that 
you created a fixture type line, which 
are several light points in a row). In the 
inspector, you will see the “PPx RGB 
Ordering” property.

This ordering must reflect the DMX 
channel distribution. In that case, the 
DMX fixture does not use a pre-defined 
layout, a custom layout can be created 
by selecting “Custom” in “PPx RGB 
Ordering”, and filling out the “custom 
ordering” section. For instance, if your 
fixture accepts 10 channels, the first 
one being intensity, the next 3 being 
RGB color, and the rest being various 
effects that you want to leave to 0, the 
layout would result in:

Letter

R
G
B
C
M
Y
W
<other>

Meaning

Red
Green
Blue
Cyan
Magenta
Yellow
White
Custom

If you add a symbol that is not on this 
table, it will be created a parameter on 
the panel, so you can manually change 
its value.

The fixture DMX addresses will start 
with 1 and accumulate the number of 
channels in the layout: 1,11,21,31 …
Then you have to connect with the 
Art-Net device (with DMX output); 

first make sure it is connected to 
the network or directly wired to the 
computer. Add a Controller, and assign 
the fixture to outlet 1 (= universe 0). 
In the Controller, you should be able 
to select the Art-Net device from the 
menu. In case the Art-Net device is not 
detected, you can add manually one. 
Just follow the next section.

To manually add an Art-Net device 
first, you have to check that you have 
manual Art-Net devices activated 
in the Global Settings. Then, select 
the controller and assign to it the 
manual Art-Net device. This device 
works exactly the same as the Art-Net 
detected devices, with the difference 
that you can manually specify the IP 
address.

Property Editing Possible Values for  DMX
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OSC Interface

ProtoPixel has a native Open Sound 
Control interface exposed in port 2345.

You can affect contents in your project 
by sending OSC messages to this 
port. The OSC address schema is like 
follows:

With those parameters:

<type> is the entity type, and at the 
moment it can only be Content.

<name> is the name of the entity

<param> is the parameter of the entity 
to be modified. You can see those 
parameter names by accessing the 
Content section in the WebApp. 

<value> is the new value of the 
parameter. It can be omitted if the 
parameter is a button.

Custom OSC bindings are also 
available in scripts. See custom_osc.
py example in the examples/scripting 
folder for more details.

Property Editing

OSC Messages Examples

If the parameter is inside a 
parameter group, you can use 
/ to separate the group from 
the parameter name. See the 
examples.

👉

Custom OSC bindings
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Integration OSC & events

You can affect the contents in your 
project by sending OSC messages to 
this port. The OSC address schema is 
like follows:

Inside a custom script, you can register 
an OSC endpoint like this:

Please take into account that if the 
number of arguments sent does not 
match the function signature, the 
message will not be delivered.

ProtoPixel Spaces can integrate 
with other elements such as 
presence sensors via its API. For more 
information consult here.

With those parameters:

<type> is the entity type, and at the 
moment it can only be Content.

<name> is the name of the entity

<param> is the parameter of the entity 
to be modified. You can see those 
parameter names by accessing the 
Content section in the WebApp. 

<value> is the new value of the 
parameter. It can be omitted if the 
parameter is a button.

Controlling Standard Contents Getting all parameters from a Content Sending OSC to Custom 
Scripts

Sending events to Spaces

https://protopixel.zendesk.com/hc/en-us/articles/8289426834321-Integration-OSC-events
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UPD Art-Net

There is also a UDP interface in port 
2344. The mechanics are the same as 
the OSC Interface. The messages are 
composed like the following:

To manually add an Art-Net device, 
first check if you have enabled manual 
Art-Net devices in the Global Settings. 
Next, select the controller and assign. 
the manual Art-Net device to it.

This device functions identically to the 
Art-Net detected devices, with the 
distinction that you have the ability to 
manually specify the IP address.

For instance:

Interface Manual Art-Net Configuration
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For more information 
and inquiries, contact 
us at protopixel.io 

https://www.protopixel.io/
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